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4. ESTIMATION OF EVAPOTRANSPIRATION IN MINAS 
GERAIS STATE, BRAZIL 

By: Elizabeth Ferreira1, Antonio Augusto Aguilar Dantas2, Alfredo Gabriel Garcia3 
 
The University of Lavras was founded in 1908 as Agricultural School of Lavras, in 1938 it was renamed School of 
Agriculture of Lavras; it was federalized in 1963 and in 1994 it became Federal University of Lavras (Portuguese: 
Universidade Federal de Lavras) – UFLA. Since then it is committed to provide and foster development and 
continuous expansion of services to society. UFLA’s force and grandeur may be measured when considering its 
current structure and future prospects. The institution is organized into 17 Didactic-Scientific departments, which act 
in different areas of knowledge. UFLA prepares more than 5,600 students in its 30 under-graduate courses (23 

classroom courses and 7 distance learning courses). There are more than 1,500 graduate students, distributed in 20 
Masters and 18 PhD degrees. In the distance-learning program, there are more than 5,000 students from all Brazilian 
states and abroad. UFLA projects to count on an enrollment of about 15,000 students by the year 2012. For further 
information see: http://www.ufla.br/en 

4.1. Introduction 

Evapotranspiration (ET) is the term used to describe the amount of water which is effectively lost from the earth 
surface to the atmosphere by soil surface evaporation and plant transpiration. ET is an important component of the 
water cycle and its importance in the hydrological cycle makes its accurate quantification necessary for calculation of 
the soil water balance, either for the detection of water stress conditions, their use as input variable in crop yield 
models or the study of ecosystem functioning and its relationship to local and regional climate, among others. The 
Brazilian Institute of Geography and Statistics 2006 Census revealed that in Brazil approximately 5.2 million 
agricultural establishments are occupying 36.75% of the national territory (IBGE, 2006). Regarding the use of 

irrigation, 6.3% of establishments reported using this technique, accounting for a 39% increase in the number of 
agricultural establishments, compared to the previous Census of 1995, furthermore resulting in an absolute increase 
of 1.3 million hectares (42%). The irrigated area, with 4.45 million ha (7.4% of the total area) under temporary and 
permanent crops, has the following means of water supply: 24% of the area is irrigated by flooding, 5.7% by grooves, 
18% has a centre pivot, 35% use other sprinkler methods, 7.3% supply water using localized methods and 8.3% is 
irrigated using other methods. The Minas Gerais State (586,528.293 km² and a population of 20,595,499 people) is 
the Brazilian state with the largest number of establishments (48.39 thousand) using some form of irrigation 
technique. A total of 3789 center pivots in Minas Gerais State have been identified as from the start of 2011 (Ferreira 
et al 2011). One of the major problems of irrigated agriculture is the correct sizing of the quantity of water 
requirements of the cultures. The estimation of evapotranspiration from data obtained by remote sensing is an 
alternative in the determination of water required by crops, especially for large areas, since the traditional methods 
using data collected using meteorological ground observations, represents only points in geographic space. 
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4.2. Objective of the application 

The objective of this application is to estimate daily Evapotranspiration (ET) using the  Surface Energy Balance 
System (SEBS) Model to know the ET pattern over irrigated areas by center pivots, in MG State, Brazil using ILWIS  
and the GEONETCast Toolbox with data obtained through GEONETCast and DevCoCast. Since the Land 
Surface Analysis Satellite Application Facility (LSA SAF) also provides an ET product (SAF ET), the estimated ET 
calculated using the SEBS model and the SAF ET product are also compared. 

4.3. Methodology  

First a brief review of the SEBS Model is presented. Su (2002) indicates that SEBS requires as inputs three sets of 
information. The first set consists of land surface albedo, emissivity, temperature, fractional vegetation cover, leaf 
area index and the height of the vegetation (or the roughness height). When vegetation information is not explicitly 
available, the Normalized Difference Vegetation Index (NDVI) is used as a surrogate. These inputs may be derived 
from remote sensing data in conjunction with other information about the concerned surface. The second set 
includes air pressure, temperature, humidity and wind speed at a reference height. The reference height is the 
measurement height of the meteorological parameters for point application and the height of the planetary boundary 
layer (PBL) for regional application. This data set can also be extracted from a large scale meteorological model. The 
third data set includes downward solar radiation and downward long wave radiation which can either be measured 
directly, obtained through model runs or using a different type of parameterization. 
According to Su et al (2005), the SEBS model (Su 2002) was developed to estimate surface energy fluxes and the 

evaporative fraction using remotely sensed data in combination with meteorological information at scales that are 
dependent on the forcing data. SEBS consists of several separate modules to estimate the net radiation and soil heat 
flux and to partition the available energy (=Rn-G0) into sensible and latent heat fluxes, as presented in equation 1: 
 

Rn - G0 = H+ λ E  (eq 1) 
Where: Rn: the net radiation; 

G0: the soil heat flux; 
H: the sensible heat flux; 
λ E: the latent heat flux. 

 
SEBS estimates the net radiation based on the radiative energy balance. The other component comprising the 
available energy is the soil heat flux. In the absence of observed soil heat flux measurements, as in satellite 
applications or at large regional scales, empirical formulations of the soil heat flux based on net radiation and the 
vegetation fraction are used to estimate the total soil heat flux for the area. The remaining variable that SEBS 
independently estimates is the sensible heat flux (H), which is solved using a combination of three equations using 

wind speed and the friction velocity. In SEBS, the model output of sensible and latent heat fluxes is also constrained 
by considering dry-limit and wet-limit conditions, which give the upper and lower boundary of sensible heat flux 
estimation. Further details on the particular techniques used to separate the sensible and latent heat flux from the 
available energy can be found in Su (2002). The SEBS model is implemented in ILWIS and BEAM (Wang et al, 
2008). The ILWIS SEBS plug-in version used here is 1.1. Note that additional information on SEBS is also available 
from the main ILWIS menu. Select the option “Help”, and select “SEBS Help”. 

4.4. Input data  

4.4.1. Local / regional (in-situ) data 

The input data (in situ) for SEBS model are: average daily wind speed at 2m (m/s), mixing ratio (kg/kg), daily air 

temperature (oC), solar net radiation at crop surface (W/m2). These data are obtained from the Climatological 
Ground Stations, that are located in the following municipalities of Minas Gerais State: Araçuaí,  Araxá,  Bambuí,  
Barbacena, Belo Horizonte, Poços  de Caldas,  Cambuquira,  Capinópolis,  Caratinga, Cataguases,  Conceição do 
Mato Dentro,  Coronel  Pacheco, Curvelo,  Diamantina, , Espinosa,  Florestal,  Governador Valadares, Ibirité,  
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Itamarandiba,  Januária,  João Monlevade,  João Pinheiro, Juiz de Fora, Lavras, Machado,  Montes Claros,  Oliveira, 
Passa Quatro,  Patos de Minas,  Pedra Azul,  Pirapora, Pompeu,  Salinas,  São João del-Rei,  São Lourenço,  Sete 
Lagoas,  Teófilo Otoni, Uberaba and  Viçosa. These data were retrieved from a CD “Normais Climatologicas do 

Brasil 1961-1990”. The specific local and regional data files needed for this exercise is listed below:  
 DEM (obtained from http://eros.usgs.gov/#/Find_Data/Products_and_Data_Available/gtopo30_info): 

GTOPO30_Minas (ILWIS map layer) 
 Climate data (CD ordered from http://www.inmet.gov.br/): 

Station_MG.txt 
 Boundaries (obtained from http://www.geominas.mg.gov.br/): 

Boundary (ILWIS map layer) 
Municipalities (ILWIS map layer)  
pivots_MG (ILWIS map layer) (from the authors) 

4.4.2. Data from GEONETCast-DevCoCast 

The GEONETCast-DevCoCast products are obtained from the LSA SAF for the South American window. 
Products used are: albedo, DSSF, LAI, LST, FVC and the Daily Evapotranspiration product. Finally, from 
DevCoCast the SPOT Vegetation S10 Maximum Value Composite NDVI was collected. The specific data files 
needed for this exercise is listed below: 

 Landsaf products (obtained from https://landsaf.meteo.pt/): 
S-LSA_-HDF5_LSASAF_MSG_ALBEDO_SAme_201005020000.bz2 
S-LSA_-HDF5_LSASAF_MSG_FVC_SAme_201005020000.bz2 
S-LSA_-HDF5_LSASAF_MSG_LAI_SAme_201005020000.bz2 
S-LSA_-HDF5_LSASAF_MSG_DSSF_SAme_201005021500.bz2 
S-LSA_-HDF5_LSASAF_MSG_LST_SAme_201005021500.bz2 
ET_Minas_geo (ILWIS map layer) 

 SPOT Vegetation product (obtained from http://www.devcocast.eu/): 

V2KRNS10__20100501_NDVI__S-America.ZIP 

4.5. Data analysis 

In order to evaluate the spatial variation of evapotranspiration using the SEBS algorithm, the data of 02 May 2010 
are analyzed. The primary data was downloaded from the GEONETCast-DevCoCast data providers. The other 
products used here were also obtained from the internet (DEM, NDVI and LSA SAF) and from a CD with Brazilian 
climatological ground station data. A flow chart describing the main (pre-) processing steps to perform the 
application is shown in Figure 4.1. 

4.5.1. Data pre-processing steps required 

Ensure that you have unzipped the exercise data and move using the ILWIS navigator to this active working 
directory. You will note that there are two sub directories, “gnc_data” and “lst”. The first directory is containing the 
raw data from GEONETCast-DevCoCast, the second one is containing a time series of Land Surface Temperature 
data. Once close ILWIS and Open ILWIS again to ensure that the directory settings are correct. You can have a look 
at the data that is available in this folder, open some of the maps and have a look at their content. 
Now, from the ILWIS menu, ensure that the GEONETCast toolbox plug-in is installed, open the “Geonetcast” => 
“toolbox”, select the option “Configuration” and Folders”. Now select the folder settings for “SPOT VGT4 Latin 
America”, set the appropriate input and output folders, note that the input folder is your active working directory 
and add here the sub-directory “\gcn_data”. Repeat this procedure and specify the appropriate folder setting for the 
“SAF South America” Products. 
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Figure 4.1 Flow chart showing the main steps to derive ET using SEBS model in ILWIS and 
GEONETCast toolbox  

4.5.1.1. Import LSA SAF products  

From “GEONETCast” and “Toolbox” main menu select “Satellite Application Facility (SAF)”, “South America” and 
“Albedo” to import the Surface Albedo product. Type the appropriate date according to the pre-defined format: 

“201005020000”. Repeat these steps to import the other SAF products (DSSF, FVC, LAI and LST). Note that to 
import the DSSF and LST the date format is “201005021500”. Check the resulting imported maps, open them and 
browse with the left mouse cursor pressed over the maps. As Representation use “Pseudo” for Albedo, DSSF and 
for LAI, FVC and LST the representations “lai_SAF”, “fvc” and “lst” respectively. You will note that there are a lot 
of “no data” values for the “lst” map, probably due to cloud cover. As this is an important input layer in SEBS 
additional attention needs to be given to this map. The temporal resolution of this product is 15 minutes and we can 
process a longer time series of data to obtain a better land surface temperature map, using more time stamps. To 
conduct this multi temporal import you are going to apply a batch looping routine, for further explanation on the 
procedure, see Maathuis et al (2011). Using the ILWIS Navigator go to the sub-directory “\lst”, you will see a 
number of ILWIS service objects that are used for the georeferencing. 
Close ILWIS from this sub-directory. With the Windows Explorer navigate to the sub-directory “\lst” and unzip the 
file “lst.zip”, using the option “extract here”. After this operation is completed, check the temporal interval of the lst 
data, note the time stamp is in UTC (local time = UTC – 3 hours)! Right click with the mouse on the file called 
“multi_lst_start.bat” and from the context sensitive menu, select “Edit”. Inspect the batch command line given and 
close the file. Now select the second batch file, called “multiSame_lstimport.bat”, again select “Edit” from the 

context sensitive menu. Now modify the directory name strings in this batch file and specify the correct path names 
where ILWIS is situated on your system (see lines 7 to 9). After the correct directory has been specified for these 
three lines in the batch file, select from the text editors main menu, the option “File” and “Save”. Close the text 
editor. Now double click with your mouse on the first batch file “multi_lst_start”. The multi temporal import of the 
lst product is now started and all SAF-lst files are now imported. Upon completion of the batch routine start ILWIS 
again and navigate to the sub-directory “\lst”. Open one of the imported lst maps and use as Representation “lst”.  
Now you are going to calculate the average land surface temperature for this time period. To do so, from the main 
ILWIS menu select the option “File => Create => MapList” and add all maps to this maplist, using the “>” icon, 
specify an appropriate Map List name, e.g. “lst_time” and press “OK” to execute the operation. First all “no data” 
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values are going to be reassigned to 0, to do so select from the ILWIS main menu, the option “Operations => 
Raster Operations => MapList Calculation”, as input map list use “lst_time”, only “1” input Maplist. As 
“Expression” type: 

ifundef(@1,0.00)  
Specify as output map list “lst_time0” and press “Show”. After calculation is finished, open one of the new maps 
created and check the result, all “no data” values have been reassigned “0.00”. Right click with the mouse the maplist 
“lst_time0”, select from the context sensitive menu the option “Statistics => MapList Statistics”, as Statistical 
function select “Sum” and specify as output map name: “lst_sum”, press “Show” to execute the command. Repeat 
this procedure and select as statistical function, the option “Count”, but now use as input map the original time 
series, called “lst_time”, call the output map “lst_count”. Note that this map gives the number of events that an 
appropriate lst value was given in the time series data! Now calculate the average lst by typing the following 
expression on the ILWIS command line: 

lst_avg:=lst_sum/lst_count  
and use all options as default. Check this output map. Right click with the mouse the map name “lst_avg” and from 
the main IWLIS menu, select the option “Edit => Copy Object to”, select the option “New Directory” and copy 
this file in the your main active working directory you used to extract all other SAF data. Use the ILWIS Navigator to 
go back to your main working directory 

4.5.1.2. Import Spot Vegetation products 

From “GEONETCast” and “Toolbox” main menu select “SPOT VGT4 Products”, “SPOT VGT4 Latin America”, and 
finally select “NDVI”. The date format to be entered is “20100501”. Open the imported map “ndvi20100501” and 
use as Representation “NDVI1”, browse with the left mouse cursor pressed over the map and inspect the values. 
Note that also a status map is created, this map is going to be applied to select only those pixels that meet the 
following criteria: cloud free, land pixel and having good radiometry in the red and near infra red channels. For 
further explanation on the procedure, see also Maathuis et al (2011). Type the following map calculation formula on 
the command line in the main ILWIS menu: 

Status_ok:=iff((((ndvi20100501_SM div 1)mod 2)+(( ndvi20100501_SM div 2)mod 2)=0) and 
(((ndvi20100501_SM div 8)mod 2)+((ndvi20100501_SM div 32)mod 2)+((ndvi20100501_SM div 64)mod 
2)=3),1,0) 

Leave all other options as default and execute the operation. Inspect the resulting map and now apply the mask, 
showing the pixels meeting the selection criteria, to the NDVI map by entering the following map calculation 
statement on the command line in the main ILWIS menu: 

ndvi_ok20100501:=iff(Status_ok=1,ndvi20100501,?) 
Again use all other settings as default and execute the operation, check the results, use as Representation “NDVI1”. 

4.5.1.3. Submap of the Minas Gerais State and resampling other maps 

With the “ndvi_ok2010050” active, add from the map menu, using the option ”Layer” and add the layer “boundary”. 
Open from the main ILWIS menu “Operations”, “Spatial Reference Operations”, “Raster” and “Sub Map”. Create a sub 
map of Minas Gerais State, using the settings of the Figure 4.2 (left hand figure).  
It is important in order to apply SEBS that all maps are in the same projection - coordinate system, same datum and 
same spatial resolution. Resample all the other imported products using the georeference of the Minas Gerais NDVI 
Sub Map. The maps will be transformed into a Plate Carree, latlon coordinate system, WGS 84 datum and ellipsoid 
and the spatial resolution of the SPOT VGT4 product used (here 0.0089285714, or 112 pixels per degree). 
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Figure 4.2 Creating a sub map of  SPOT VGT4 NDVI for Minas Gerais State and sub map details  
 
To resample the LSA SAF products and GTOPO30_MINAS digital elevation model follow the instructions below: 

first right click the mouse over the map that you want to resample and choose “Spatial Reference Operations => 
Resample”. For resampling settings select the specifications given in figure 4.3. Repeat the procedure to resample 
also the other maps like Albedo, LST_avg, LAI, DSSF, FVC and GTOPO30_minas. Here the file name prefix “re_” 
is used for the resampled output maps. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.3 Resampling settings and the resulting Albedo sub map 

4.5.1.4. Change of units for LST and ALBEDO of the Minas Gerais Sub Maps 

Take special care of the following steps, because they are required to run SEBS and derive the ET. The LST units 
have to be changed from degrees Celsius to Kelvin and for the Albedo map from percentage to ratio. 
To do this for the LST Minas Gerais sub map (re_lst) type in the following expression in the ILWIS command line:  

re_lst_kelvin:=re_lst+273.15 
Keep all other options default and press “OK” to execute the operation. To change the units of the Albedo sub map 
(re_Albedo), from percentage to ratio, type the following expression in the ILWIS command line: 

re_albedo_ratio:=re_albedo*0.01 
Keep all other options default and press “OK” to execute the operation. Check the results of the operations. 

4.5.1.5. Calculate Emissivity, Solar Zenith Angle and derive downward solar radiation 

To calculate the emissivity, using the procedure according to Valor and Caselles (1996), type the following expression 
in the ILWIS command line: 
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re_emis:=0.985*re_fvc+0.96*(1-re_fvc)+0.015  
Keep all other options default and press “OK” to execute the operation. Check the resulting map.  
From the “GEONETCast” and “Toolbox” main menu select the option “Calculate MSG Angle”, “Calculate solar 

and satellite zenith angle maps for MSG field of view” and type for year 2010, Month 05, Day 02 and hour (UTM) = 
15.00. Note that the appropriate output directory is assigned correctly! The resulting map, called “sol_zenres”, 
should be resampled using the NDVI sub map georeference (ndvi_minas). Your results should resemble those of 
figure 4.4. 
 

Figure 4.4 Solar zenith angle of MSG for the full disk and resampled to the Minas Gerais georef 
 
The downward solar radiation data can be spatially represented by a map, e.g. using the LSA SAF DSSF product, or 
by a single value. In this case a single value of 623 W/m2 is derived, being the mean value obtained from the 
operational meteorological ground station in MG State at 15:00 hrs (data obtained from: 
http://sinda.crn2.inpe.br/PCD/historico/consulta_pcda.jsp). Note that a UTC time of 15:00 hours corresponds to 
12:00 hour’s local time. 02 May corresponds to Julian day number 122 (sum of days for a given year, starting from 01 
January: 31+28+31+30+2). Note that you have already imported and resampled the DSSF product previously! 

4.5.2. Import table and processing of in situ data  

From the ILWIS main menu select “File => Import => ILWIS => Table => Space delimited”. Choose 
“Station_MG.txt” file as input file and as output file type “Station_MG”. Press “OK” and “Next” to continue 
importing the data, in the “Edit column detail” window, by double clicking and typing in each line of the first column 
the appropriate column name: Y (column1), X (column2), Temp (column3), HumityRel (column4), Pressure 
(column5), Mix_ratio (column6), Ins_hrs (column7) and Windspeed (column8). Edit all column names and press 
“OK” to import the table. The “Edit column detail” is also given in figure 4.5 and the resulting imported table is 
presented in appendix 1. 

Figure 4.5 Editing first column of each line with appropriate column name 
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Select from the ILWIS main menu “Operations => Table Operations => Table to point map”. Specify identical 
settings as those given in the left hand picture of figure 4.6 and press “Show”. To see the resulting point map with 
the distribution of INMET climatological ground stations, open the vector map “boundary”, using default settings, 

select “Add layer” from the map window menu and select the point map “station_MG”. 
 

Figure 4.6 Table to point map conversion and INMET ground stations distribution  
 
As can be seen from the imported table showing the climatological observations, for the columns “Ins_hrs” and 
“Mix_ratio” hardly any differences appear. The mean value for these variables would be a good approximation for 
the whole area. For the columns “Windspeed”, “Pressure” and “Temp” a larger variation occurs, this could be 
spatially represented if there is a correlation with elevation. 
To determine if there is a correlation, first transform the point map to a raster format, right click with the mouse the 
point map “station_MG”, from the context sensitive menu, select the option “Rasterize => Point Map to Raster”, 
use as georeference “NDVI_Minas” and leave other options as default given, press “Show” and “OK”. Look 
carefully, eventually Zoom-in, as the stations are presented using a single pixel! Next step is to cross the rasterized 
point map with the elevation model, in this case the resampled GTOPO30 DEM (see again section 4.5.1.3), here 
called “re_gtopo30”. 
Select from the main ILWIS menu “Operations => Raster Operations => Cross”, as first map select the map 
“re_gtopo30” and as second map, select from the map “station_MG”, by pressing the “+” sign in front of the map 
name, the table column “Temp”. As output table specify “dem_temp” and press “Show”. Open the table and from 
the active table menu, select “Columns => Statistics” and select as function “Correlation”, note the column 
assignment and press “OK”. Note that there is a reasonable correlation between the variables elevation and 
temperature (R=-.757). From the table Menu select “Column”, “Least Squares” and for the X-column select 

“re_gtopo30” and the Y-column “map2” (representing the variable Temp), specify as output column “dem2temp”. 
Use as function “polynomial”, “Nr. of terms” of “2” and press “OK” to execute the operation. In the column 
properties window select the option “Additional Info”, here the function is given that needs to be used later to 
transform the elevation map to temperature. Note down the equation, press “OK” to close the window, leave the 
other options as default and press “OK”. A new column, called “dem2temp” is now added to the table. Check the 
results obtained in the table. 
Repeat the procedure to derive the relationship between the gtopo_30 elevation model and the check the new 
column “pressure” from the table “station_MG”. 
 
Transform the re-gtopo30 elevation model into air temperature (in degree Celsius) and pressure reference height (a 
height of + 2 meters is used in SEBS, in Pa) using the following equations (that you have derived in the previous 
steps) by typing the expressions in the ILWIS command line: 
 re_air_temperature:=24.096+-0.006*re_gtopo30 
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Keep all other options default and press “OK” to execute the operation. Repeat it to derive the “reference pressure” 
by typing the following expressions in the ILWIS command line: 
 re_pressure_reference:=100355.628+-9.175*re_gtopo30 

Keep all other options default and press “OK” to execute the operation. To derive the pressure at the surface a mean 
daily air temperature of 20 degree Celsius is used which accounts for a pressure increase of 23 Pa over a 2 meter 
difference as a Reference Height of 2 metres is assumed during the collection of the field observations. To obtain the 
pressure at the surface type the following expressions in the ILWIS command line: 

re_pressure_surface:=re_pressure_reference+23  
Keep all other options default and press “OK” to execute the operation. Check your results obtained, use as 
Representation “Pseudo”. 
 
To get a spatial representation of the windspeed, as there is no correlation with the elevation model, a different 
approach has to be followed. Select from the main ILWIS menu, the options “Operations => Interpolation => 
Point Interpolation => Moving Average”. Specify the column “windspeed” from the point map “Station_MG (press 
the “+” sign in front of the point map and select the appropriate column), use the option “Inverse Distance” as 
Weight Function, leave the default “Weight Exponent” as “1” and check the option “Use Spherical Distance”. 
Specify as Output Raster Map “re_windspeed” and select the georeference “ndvi_minas”, Press “Show” to execute 
the operation. Check your results obtained, use as Representation “Pseudo”. 

Correct the obtained windspeed map to represent the windspeed at the surface by using a correction factor. Type the 
following expressions in the ILWIS command line: 
 Re_windspeed_cor:=re_windspeed*0.75 
Keep all other options default and press “OK” to execute the operation. Check your results obtained, use as 
Representation “Pseudo”. 

4.6. Running SEBS in ILWIS 

After all pre-processing you are now able to run SEBS. Choose “Operations”, “SEBS Tools” and “SEBS” from the 
main ILWIS menu. See also figure 4.7, indicating all input maps required to run the SEBS plu-in. Ensure that all 
input maps are correctly specified as well as the single values, representing the various model parameters. Note that 
you can run SEBS twice, the first run with a single “Instantaneous Downward Solar Radiation Value” of “623 
W/m2” and for a second run, active the check box in from the “Inst. Downward Solar Radiation Map (W/m2 )” and 
use as input map the resampled DSSF map, called here “re-dssf”. Figure 4.8 shows the SEBS daily 

evapotranspiration results in mm/day for both runs. 
Note that once SEBS has completed the computation, select the map “SEBS_Daily_Evap”, when SEBS is started 
again a new daily evaporation map is produced, called “SEBS_Daily_Evap__1”. From the command line, pressing 
the command line history drop down button (on the right hand side of the command line in the main ILWIS 
window) the SEBS command line can be extracted. The example command line below is the result of the 
specifications given in the entry menu form of figure 4.7. If small changes have to be implemented the parameters 
can be easily replaced using the command line, instead of filling out the full form. The example command line is give 
below: 

sebs.mpr=MapSEBS(re_lst_kelvin,re_emis,re_albedo_ratio,ndvi_minas,1,re_lai,1,re_fvc,1,re_solzen,0,1,re_ 
gtopo30,0,1,122,0,0,0,2,1000,0,,0.0109,1,Re_windspeed_cor,2,1,re_air_temperature,25,1,re_pressure_refere
nce,100000,1,re_pressure_surface,100100,39.2,1,623,0,nomap,0,nomap,0,nomap,0,nomap,0,,20,0,,7) 

 
Note that for the specific humidity the average value of the column “Mix_ratio” is used from the table 
“station_MG” and the following equation has been applied: specific humidity in kg/kg = mix_ratio/(1+mix_ratio), 
or 0.011/(1+0.011). For the sunshine hours per day the average value is extracted from the climatological data 
presented in the table “station_MG”, roughly amounting 7 hours of sunshine. KB^-1 is the inverse Stanton number, 
a dimensionless heat transfer coefficient and can be left default.  Display your SEBS results, using as Representation 
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“sebs_ET” available from your main working directory. Your results should correspond to those given in figure 4.8 
below. Inspect your daily ET values obtained (unit in mm/day). 
 

 Figure 4.7 SEBS data entry form in ILWIS  

Figure 4.8 SEBS daily ET (mm/day), using single downward solar radiation value (left) and LSA SAF 
DSSF map (right) 

4.7. Derive statistical information aggregating  Minas Gerais state and center pivot area 

Now you are going to use the SEBS daily evapotranspiration results (sebs_ daily _evap) to extract the information 
for the whole Minas Gerais state and for each center pivot area. To obtain the information for Minas Gerais state 

only, first display the map “SEBS_Daily_Evap” and add the vector layer “boundary”. In the “add layer” display 
options uncheck the option “Info” activate the option display “Boundaries only”. 

Convert the polygon file “boundary” to a raster map format, select from the ILWIS main menu “Operations => 
Rasterize => Polygon to raster”. In the “Polygon to raster” window select the vector layer “boundary” and select the 
georeference “NDVI_Minas”. As output map type “boundary” and press “Show” and subsequently “OK” to see the 
newly created rater “boundary” map. 
Now mask the two ET maps created with SEBS using the boundary raster map. Type the following expressions in 
the ILWIS command line: 

sebs1_mask:= iff(boundary="1",sebs_daily_evap,?) 
sebs2_mask:= iff(boundary="1",sebs_daily_evap__1,?) 
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Keep all other options default and press “OK” to execute the operation. Check your results obtained, use as 
Representation “sebs_ET”. To obtain some general statistics, right click with the mouse the map “sebs1_mask” and 
select from the context sensitive menu the options “Statistics => Histogram” and press “Show”. Repeat the 

procedure also for the map “sebs2_mask” and check and compare the results. 
Another way to get statistical results is by classifying the continuous data range into user defined classes. To do this a 
domain is used. Double click on the domain “sebs_cl” and take note of the classes that have been defined. From the 
main ILWIS menu, select the option “Operations => Image Processing => Slicing” and specify as raster map 
“sebs1_mask” and as output raster map “sebs1_mask_cl” and as domain “sebs_cl”, press “Show”. The resulting 
map is now classified according to the data ranges specified by the domain. Close the map and right click with the 
mouse the map “sebs1_mask_cl” and select from the context sensitive menu the options “Statistics => Histogram” 
and press “Show”.  
Repeat the classification procedure also for the map “sebs2_mask”, check and compare the results. 
 
To obtain the ET information, but now for each center pivot, a polygon map “pivots_MG” is available. First display 
the vector map “boundary” and add the layers “pivots_MG” and “municip”, see also figure 4.9. Convert the polygon 
map “pivots_MG” to a raster map format, select from the main ILWIS menu “Operations => Rasterize => 
Polygon to Raster”. As output raster name type “pivots_MG”, as georeference use “ndvi_minas”.  
 

Figure 4.9 Map detail showing various vector layers of irrigated areas by center pivots 
 
To obtain a table with statistical results per pivot, select “Cross” (from the ILWIS main menu select “Operations => 
Raster Operations”) and use the raster map “pivots_MG” and the SEBS daily evapotranspiration map, here called 
“sebs_daily_evap”. Specify as first raster map “pivots” and as second raster map “sebs_daily_evap”. Specify as 
output cross table “sebs_pivots”. Keep the other options as indicated by default. Now aggregate the daily 
evapotranspiration from SEBS and append this as a new column into the table “pivots_MG”. To do this select from 
the “sebs_pivots” table menu the option “Column” and from the drop down list select “Aggregation”. Specify the 
settings according the figure 4.10. 
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Figure 4.10 Aggregating the daily evapotranspiration from SEBS to pivots areas 
 
Display the ET_Minas_geo raster map, using a “Pseudo” Representation, the map is provided in your main working 

directory. This raster map was obtained from the LSA SAF, the so called ET-product.  The temporal resolution of 
this product is 30 minutes, so the 48 time steps have been aggregated to get a daily ET map, in a similar manner as 
how the LST map was created. Already an appropriate sub map has been made.  
The same method to get the statistical results from SEBS can be used to obtain the statistics from the ET LSA SAF 
map called “ET_Minas_geo”. From the ILWIS main menu select “Operations => Raster Operations”, select the 
function “Cross” and specify as first raster map “pivots_MG” and as second raster map “ET_Minas_geo”. Specify 
as output cross table “saf_ET_pivots”. Now aggregate the daily evapotranspiration from the column 
“ET_MINAS_geo” into the “pivots_MG” table, call the column “avg_et_saf”. To do this select from the table menu 
“Column” and from the drop down list the function “Aggregation” and specify as output column “avg_et_saf”and 
as output table “pivots_MG”, press “OK” to execute the operation.  
 
Open the table “pivots_MG” and inspect the two newly added columns. Type the following expression on the table 
command line:  

difference:=avg_sebs-avg_et_saf 
Keep all other options default and press “OK” to execute the operation. Check your results obtained. 

4.8. Conclusions 

The SEBS model was used to estimate the daily evapotranspiration for the 2nd of May 2010. The results show an ET 
ranging from 2.063 to 4.321 mm/day in the Minas Gerais State using a single instantaneous solar downward 
radiation value and an ET ranging from 2.633 to 4.560 mm/day using the LSA SAF DSSF product (using 0.5 % 
cutoff interval). More detailed statistics, like mean, standard deviation and median reveal that the overall results look 
quite comparable despite the fact that the last ET estimation is slightly higher as a single time step noon image (local 
time) was used. The daily aggregated ET LSA SAF product gives ET values in the range of 0.01 to 4.21 mm/day, 
showing a larger difference between the SEBS ET estimation (both runs) and the one obtained from the LSA SAF.  
Considering that for the SEBS model runs a lot of local climatological - meteorological in situ input data was used, 
we consider that ET estimated using SEBS are more realistic compared to those from the ET LSA SAF and that the 
last one is slightly underestimating the ET. Further validation is required using local in situ ET observations. It is 
important to consider that a number of input layers used in the SEBS model are actually derived from other LSA 

SAF products, also used in the computation of the ET LSA SAF product. 
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APPENDIX 1 

Table with “in-situ” data of meteorological ground stations for Minas Gerais. 

 
 
 
 
 
 
 
 
 
 

 
 
 
 


